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1. Enable NGI Functionality

The following four requirements must be met prior to the FBI enabling your ORI for
Next Generation Identification (NGI) Increment 3 functionality:

1. EBTS version 9.3 (or greater) compliance - additional EBTS fields are returned
with the NGI latent responses (e.g., 2.2033 CNL field).

2. ORI Authorization - if you are a Direct Latent Connectivity (DLC) agency, the
FBI will NGI enable your specific ORI. If you’re not a DLC agency, the FBI
must enable your conduit’s ORL

3. Type-15 image capable - ability to handle any transaction containing palms.
4. 50MB incoming email file size - NGI responses are much larger than the average

IAFIS 2MB responses, therefore, your agency’s mail management system should
be able to accept 50MB minimum per file / message.

If the FBI has formally transitioned your agency or conduit to take advantage of NGI
INC-3 services / capabilities, the ULW software’s settings must be configured properly.
See instructions below to ensure the appropriate NGI box is checked.

Close all ULW applications

Open ULW-LE (suggest using the ADMIN login)

Go to File > Program Settings > Application Defaults

Check the box next to “Enable NGI Functionality”

Click OK

Close the Latent Editor

Open the Transaction Manager... NGI Functionality will be enabled

GmMmooOw>

HE ality
Automatically Submit BDEC Transactions




If not yet transitioned, the ULW should be used in legacy mode by confirming this box is
unchecked.

A
B.

. Lost setting workaround for ULW

Close all ULW applications.
Open ULW-LE, go to “Program Settings” and ensure all settings are correct.
o Make certain the correct Controlling Agency Identifier (CRI) is entered
because it’s automatically deleted each time the ULW software is
upgraded.

Copy the latent-settings.xml file from the folder in the “From” column for your
Operating System and replace the existing file in the “To” folder.
o These folders may be hidden; either change your settings or simply type
the path in the address field.
o If the user doesn’t have permission to modify the “To” folder, this step
will require the assistance of an IT Administrator.

Windows

From To

XP

C:\Documents and Settings\<windowsloginid>\Local C:\program files\ULW\
Settings\Application Data\ULW\ LatentEditor\

Vista

(64 bit) C:\program files (x86)\ULW\
OR
(32 it) C:\program files\ULW\

C:\Users\<windowsloginid>\AppData\Local\ULW\
LatentEditor\

. After the user performs the above step, their default settings will be specific to

that organization/user so when ULW reloads the settings file (in those rare cases),
it will be loading the values specific to the organization/user.

If users are also losing settings from CT and TM, please contact ULW@Ieo.gov
for assistance.

3. File Penetration settings

With NGI, stringent file penetration threshold requirements are no longer a requirement;
however, penetration rates of 50% or less are recommended. This will decrease NGI
response times by minimizing system resource demands.

NOTE: When a user enters a palm submission, the penetration rate remains at 100%.
Please be advised that this is not an error. Currently, penetration rates are unavailable
because the National Palm Print System (NPPS) repository is not filled to a high enough
capacity to generate accurate percentages.



mailto:ULW@leo.gov

4. Unknown Friction Ridge - Searching

At this time, users should refrain from performing "Unknown Friction Ridge" (2.074
FGP = 18) searches as neither responses nor error messages will be returned. In lieu of,
NGI recommends using both of the following in the same search:

e Unknown Finger (2.074 FGP = 00)
e Unknown Palm (2.074 FGP = 20)

NOTE: when performing latent searches using any palm FGP, including “Unknown”
codes 18 and 20, the Request Features Record (2.095 RFR) box should always be
unchecked.

5. Unknown Friction Ridge - Response

When a user searches "Unknown Friction Ridge" (2.074 FGP = 18) and the Number of
Candidates Returned [2.079 NCR] is 20, the NGI returns an "Unknown Friction Ridge"
response consisting of 60 total candidates:

e The first 20 candidates are tenprint,
e The second 20 candidates are upper palm,
e The final 20 candidates are lower palm (including writer’s palms).

Any time the Number of Candidates Returned [2.079 NCR] is modified, you can still
expect to receive three times that number of candidates within your "Unknown Friction
Ridge" response. For example, if NCR is changed to 10, then:

e The first 10 candidates are tenprint,
e The second 10 candidates are upper palm,
e The final 10 candidates are lower palm (including writer’s palms).

6. R0002 ERRL - Deployed NGI Latent Friction Ridge (LFR) system
limitations that could fail

e An “Internal Segment Error” is the error message returned when the Request
Features Record (2.095 RFR) box is checked.

Workaround: The user needs to un-check the 2.095 RFR box and
resubmit the transaction:

TM-File Penetration Tool > LE-Text Fields > 2.095

e Users should ensure submission values for Native Scanning Resolution (1.011
NSR) and Nominal Transmitting Resolution (1.012 NTR) match. If not, errors
will be returned.



7. S0002 ERRL - A general segment error was detected that is not
currently defined

S0002 Optional Error Message: “Matcher adapter returned an error
from a latent search to the FRIF”

These errors are generated when a submitted image is smaller than the
minimum required .384" horizontally by .384" vertical dimensions. It is
recommended that when this message is returned, the contributor examine the
submitted image’s size. If the image size does not meet required minimums, it
is recommended adding white space and resubmitting to NGI. If the

same “Matcher adapter...” message is received a second time, please report the
error to the Latent and Forensic Support Unit < latentsupport@leo.gov > for
additional research.

S0002 Optional Error Message: “Matcher timeout"

Upon receiving this specific error message (i.e., ending in "Matcher

timeout™), the transaction should be resubmitted one additional time. If the
same "Matcher timeout" error message is received a second time, please report
the error to the Latent and Forensic Support Unit < latentsupport@]leo.gov >
for additional research.

8. E0002 ERRL

“Element T4_FGP with value of 20 contains invalid data”

If the user wants to search NGI palms, one of the following workarounds can
be used...

o Record must be changed from Type-4 to Type-13

o If the original image (bmp, tiff, or jpeg) is still available, create a
completely new Type-13 file to search NGI palms

o If the original image cannot be located, a completely new Type-13 file
must be created from the original Type-4 image. The following steps
can be used to export the image embedded in the pre-existing Type-4
image file:

= |In ULW-Latent Editor, click Open/Import EBTS File button
= Navigate to the vendor’s file

= Click YES for Create feature set

= File > Export Image > Export Original Image (or CTRL + E)
= Save File on Desktop

= Create a new search using this image
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e “Element T9_ROI_ROP - Too many vertices, more than 99 vertices”
Workaround: the user needs to redraw the ROI and resubmit the transaction.
e “Element T13_FGP, with value of # contains invalid data”

This error occurs when the user selects one of the grayed-out Friction Ridge
Generalized Position (2.074 FGP) codes flagged as a Future Capability (e.qg.,
37, 38, 81, 82, etc.) in the EBTS when searching palmprints. This specific
error is identifiable since one of these numbers (37, 38, 81, 82, etc.) will be
received in the returned error message.

Workaround: The user needs to deselect all grayed-out Future Capability
palmprint position codes and resubmit the transaction.

9. ERRL returned from valid LFFS search of supplemental image

Searches of supplemental (joint and tip) images are limited to a single finger segment
(i.e., distal, medial, proximal, or tip) for each finger position being searched.

As an alternative, users can either:

e Submit searches of the upper palms (2.074 FGP = 26 “Right Upper Palm” and/or
2.074 FGP = 28 “Left Upper Palm”) when searching for multiple finger segments.

or

e Submit “Unknown Friction Ridge” searches (2.074 FGP = 18) which will include
searching the upper hand. NOTE: when the Number of Candidates Returned
(2.079 NCR) is defaulted to 20, a total of 60 candidates will be returned.

10. ULD failure when submitting Cloned Searches

To pass NGl validation, the Contributor Case Identifier Extension (2.011 CIX) value,
Contributor Assigned Identification Number (2.2022 CIDN), and Controlling Agency
Identifier (2.073 CRI) of the Unsolved Latent Delete (ULD) must match the CIX, CIDN,
and CRI values of the Unsolved Latent File (ULF) deposit. When they do not exactly
match, the ULD fails.

Workarounds:

e Do not add a cloned search file to the ULF. Instead, use the original search to
deposit into the ULF.



e If you receive an error message for your ULD, generate the ULD from the cloned
file as usual, open the file in the Latent Editor (LE), change the CIX in the ULD
to mirror the CIX in the cloned file, and submit.

11. ULW Transaction Manager not able to retrieve SRL

e Error message states: “Number of minutiae and fingerprint image
records do not correspond; cannot save”

o This error occurs when the response file contains an error preventing
any ULW application (i.e., Transaction Manager (TM), Latent Editor
(LE), Comparison Tool (CT), or ANSINISTViewer) from loading
it. The user should make certain the Request Features Record (2.095
RFR) box is not checked in the search file. This should eliminate the
error and allow the file to both load and open successfully.

o If your response file is still not importing into TM and 2.095 RFR is
unchecked, please contact < latentsupport@leo.gov > for assistance.

12. Invalid Image Resolution

The following error windows have all been associated with invalid candidate image
resolution being returned in SRLs and IRRs. At this time, the images can be viewed in
Transaction Manager - View Images and in the Latent Editor (with a pop-up on every
image noting the error). The SRL images cannot be viewed in Comparison Tool,
however, as a workaround, users can submit an IRQ for the candidate UCN and then use
the IRR in the Comparison Tool instead.

Error P4

'6' Error Code: -51

Error Log:
ERROR : huffman_decode_data_mem [2]: Decoded data extends past
image buffer. Encoded data appears corrupt or non-standard.

OK
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ImagekEdit [éj

The resolution field for this image is set at 431 pixels per inch,
i ! " but ULW is only configured to work with resolutions of 500 or

1000 ppi.

Some functions such as Minutiae extraction are not possible

Failed to open EftsFile:
ChlUsersikmwoods\AppDatatLocalhTemp'1\tmpDBED.trmp for the following
reascn,

Invalid resclution or pixel depth for a local quality map

13. Grey, Blank, or Black Images

When attempting to open a ULM, SRL, or IRR, users have experienced issues whereby
tenprint images cannot be viewed.

Grey Images: by default, ULW is deployed with the NIST decoder. When the
NIST decoder attempts to open files encoded with a non-conforming

WSQ compression algorithm, grey images result. NIST cannot change their
decoder to enable ULW to open these images and the non-conforming WSQ
software cannot be incorporated into a future ULW release. Therefore, neither
current nor future versions of ULW will be able to open these particular images.
However, users who have purchased AWARE wsq.dll compression software
should be able to open the images. Users encountering unresolved grey image
complications should contact the Latent and Forensic Support Unit

< latentsupport@Ieo.gov > for assistance.

Blank or Black Images: these images contain incorrect compression ratio
values. It is anticipated the next ULW software release will open these files
without issue. Users encountering unresolved blank/black image complications
should contact the Latent and Forensic Support Unit < latentsupport@leo.gov >
for assistance.
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14. Misaligned Minutiae

Instances of misaligned minutiae have been observed in some SRL’s when features are
requested (2.095 RFR = yes). It has been determined that this is an issue resulting from
incorrect Type-1 NSR/NTR compression information being associated with that specific
candidate. When the actual resolution of the image is not accurate, precisely overlaying
the features returned is impossible since the offsets to the minutiae locations are based on
the resolution of the image returned. Please report the FBI/UCN numbers of these
misaligned minutiae candidates to the Latent and Forensic Support Unit

< latentsupport@Ileo.gov >.

= Undetermined [Tl

15. Printing from within Comparison Tool (CT)

When printing from Comparison Tool, users have experienced an issue whereby the top
1/8 inch or more of the page is cut off - sometimes also including the Case ID number.

Workarounds:
e The size of the printed image can be modified by selecting “File”, then “Print
Preview”, then “Scale” (7" from the left on the toolbar), and decreasing the
“Adjust To” to approximately 90% (+-).

or

e From “Print Preview”, export as a PDF to the desktop. Open the PDF and print.

10
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16. Direct Latent Connect (DLC) users not receiving latent
response messages

Please be cognizant of your Law Enforcement Online (LEO) email capacity as it will
prevent the receipt of NGI latent response messages if you are using Direct Latent
Connect (DLC).

When your incoming LEO mailbox exceeds the set 300MB maximum capacity quota,
LEO allows for a limited grace period by queuing your email for seven days. If

you reduce your mailbox size, the mail that is queued will be delivered. After day seven,
any additional emails will not be queued or delivered to the intended recipient - instead a
failed delivery message including the queued email will be returned to the original sender
as a failed email delivery attempt.

To correct, make certain you delete any unnecessary items in both your inbox and sent
mailbox and, finally, empty your LEO trash.

17. Incoming Mail Server Settings

Users must increase their incoming mail server’s acceptable file size to a default of
50MB in order to accept larger NGI responses.
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